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Audio interface and control surface

Functions of the audio interface and control surface

This section explains how to set up and use the functions of the R16 audio interface and 
control surface with DAW software installed on your computer.

 Control surface functions
The on-board control surface functions can 
be used to control DAW software on your 
computer via USB. Transport operations, 
including playback, recording and stopping, 
and physical control of the DAW faders 
are possible. Furthermore, various other 
DAW software functions can be mapped 
to the F1~F5 keys. (The available functions 
depend on the DAW software used.)

DAW software
Cubase LE, etc.

Windows/Mac

USB Cable

R16

 [PHONES] jack
Playback device like 
headphones or an 
audio system

[OUTPUT] jacks
Stereo system,
speakers with built-in 
amplifiers, etc.

[INPUT 1-8] jacks
Guitars and other 
musical instruments,
internal stereo mic

Audio driver

プラグのイメージ

 Audio interface
The various input and output jacks of the 
R16 can be used as a Hi-Speed USB (USB 
2.0) audio interface with support for 8 ins 
and 2 outs and input and output quality up 
to 24-bit/96kHz. Effects can also be used 
when the sampling rate is 44.1 kHz, and 
the unit can be powered by the computer’s 
USB bus. 
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 Multifunction tuner
In addition to standard chromatic tuning, 
the multifunction tuner also has on-board 
support for 7-string guitar, 5-string bass 
and various drop tunings.

 Comprehensive built-in mixer
Using the R16’s mixer, you can make a 
mix for monitoring live and playback. When 
simultaneously recording guitar and vocals, 
for example, you can independently adjust 
volume balance, panning and reverb levels.

 Versatile effect functions
The insert effect can be applied to specific 
channel paths and the send/return effect 
works via the mixer send/return. The two 
kinds of built-in effects can be applied when 
recording, of course, but they can also be 
applied to affect only the monitoring output. 
For example, when recording vocals, you 
can apply reverb to the monitor signal to 
make singing easier, but record a dry signal.

 Supports input from a variety 
of sources, including guitars, 
mics and line level instruments.
The 8 onboard jacks, which accept XLR 
and standard phone plugs, include one 
high-impedance input and two with 48V 
phantom power. From high-impedance 
gu i tars  and basses to dynamic and 
condenser microphones and line-level 
devices like synthesizers, many sources are 
supported.  In addition, the built-in high-
performance condenser microphones are 
convenient for recording acoustic guitar and 
vocals.



4

A
u

d
io

 in
terface m

an
u

al

R16 audio interface system environment
To use DAW software with this unit, you need to install it and make settings in it for the R16. This is an expla-
nation for doing so with Cubase LE.

Please refer to the Cubase LE Startup Guide for 
detailed instructions for installing the R16 audio 
driver and Cubase LE.

R16 audio interface system 

requirements

Cubase LE installation guide

Windows
Windows® 7 (32-bit, 64-bit) or later
32-bit: Intel® Pentium® 4 1.8 GHz or faster 
64-bit: Intel® Pentium® Dual Core 2.7 GHz or faster 
32-bit: RAM 1 GB or faster 
64-bit: RAM 2 GB or faster 

Intel Mac
OS X 10.9 or later
Intel® Core Duo 1.83 GHz or faster 
RAM 1 GB or faster 

Both
USB 2.0 compatible port

* USB hubs are not supported.

About the screen images
The screen images are of the Windows version. 

About trademarks

 · The SD symbol  and  SDHC symbol are trademarks. 

 · Windows®/ Windows 7® are trademarks or registered trademarks of Microsoft®. 

 · Macintosh® and Mac OS® are trademarks or registered trademarks of Apple Inc. 

 · Steinberg and Cubase are trademarks or registered trademarks of Steinberg Media Technologies GmbH Inc. 

 · Intel® and Pentium® are trademarks or registered trademarks of Intel Corporation.

 · MACKIE Control is a trademark or registered trademark of LOUD Technologies. 
 · All other trademarks, product names, and company names mentioned in this documentation are the property 
   of their respective owners.
 · All trademarks and registered trademarks mentioned in this manual are for identification purposes only and are 
   not intended to infringe on the copyrighted properties of their respective owners.
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Connecting and disconnecting in audio interface mode

Reference: “Cubase LE Startup Guide”

Install/setup details

This is a brief overview of connecting and disconnecting when a computer is hooked to the R16 
by USB cable. For details, please refer to the separately attached “Cubase LE Startup Guide”.

Connecting the R16 to the  
computer for the first time

Connect the R16 to the computer.

R16 setup and connection

Setup DAW software

Device setup

Install Cubase LE DAW software 
on the computer1 1 Press [USB].

USB	
>AUDIO INTERFACE

Change 
menu

Press [Enter].

Select >AUDIO INTERFACE .
Download the latest ZOOM R16 /
R24 audio driver from the ZOOM 
website (see below).

2 2

SETTING?
[CONTINUE] RESET

Change 
menu

Press [Enter].

Select “Continue.”4

AUDIO INTERFACE
Enter?

Press [Enter].

 Verify.

Install the audio driver on the 
computer.3

5

4

3

R16 setup and connection
Follow these procedures from the second time connecting

  NOTE

The ZOOM R16/R24 audio driver is essential 
for using the R16 as an audio interface for DAW 
software such as Cubase LE.
When downloading, follow the included instruction 
guide to install correctly.

 Please download the latest R16 audio
    driver from Zoom Corporation’s website 
    at (http://www.zoom.co.jp).

  NOTE
•	 Set the recording quantization (bit depth) of 

Cubase LE or the DAW software that you are 
using to 24-bit in order to achieve the best audio 
quality when recording. (See the software manual 
for how to make this setting.)

Control surface setup (Mackie Control) P.7

☞ Reference: "Cubase LE Startup Guide" 
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 · The audio interface and control surface functions 
of the R16 can be used by drawing power 
through the USB bus. Power from batteries or 
the adapter is not necessary.

 · We recommend always using the latest R16 
system software. Operating the R16 with an older 
system could result in it not being recognized by 
your computer.

1 Press [USB].

AUDIO INTERFACE
Terminate?

Press [Enter].

Terminate the connection.2

Remove the USB cable.3

The [DEVICE] USB indicator will light.

Sample Rate=44.1kHz
s:Solo

Connect the USB cable to the R16.5

Connect the USB cable 
to the computer.6

AUDIO INTERFACE icon blinks

When connection is complete the AUDIO 
INTERFACE icon appears.

Connection setting 
complete

  NOTE

Disconnecting

Data transferred with CONTINUE
 · INSERT EFFECT settings
 · SEND RETURN EFFECT settings
 · Track parameter settings
 · TUNER settings

RESET
Restores default settings for each item
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Using the control surface functions
When using the R16 connected by USB as an audio interface, the R16 keys and faders can 
be used to control Cubase LE’s transport and mixer.

  HINT
Assigning Keys
For a list of functions that can be assigned to 
the knobs and keys of the R16, as well as other 
transport/function keys that are supported by 
Cubase LE, please consult the “Control Surface 
Mode Functions Quick Reference Guide” of this 
manual.

About the control surface Control surface settings

In control surface mode the keys and knobs on 
the R16 can be assigned to particular Cubase 
LE  functions.

7 Launch Cubase LE.

Transport section 	 p.8

About banks 	 p.9

Fader section	  p.9

Reference: Control Surface Functions Quick Reference Guide p.12

8 Select “Device Setup” from the 
Cubase LE “Device” menu.

9 On the top left of the device 
setup window there are [+] [-] 
[|<] buttons. Click the [+] and 
then choose “Mackie Control.”

10 Set MIDI input and output.

MIDI Input: Zoom R16_R24

MIDI Output: Zoom R16_R24

See R16 setup and connection 
steps 1~6 on P.5~6.

  HINT
The display of MENU etc. may be different 
depending on the version of Cubase LE.
Please refer to your Cubase LE manual.
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Transport section

By setting up the control surface, the R16’s 
transport section keys can be assigned to 
individual functions in Cubase LE

［REW］キー ［FF］キー ［STOP］キー［PLAY］キー ［REC］キー

［F1］キー ［F5］キー［F2］キー ［F3］キー ［F4］キー

巻き戻し　 早送り 　　停止　　  再生　　  録音　

[F1 ]  Key   [F2 ]  Key   [F3 ]  Key   [F4 ]  Key   [F5 ]  Key

[REW] Key   [FF] Key   [STOP] Key   [PLAY] Key   [REC] Key 
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Fader section operation
By using the faders and status keys of the R16 fader section, you can control the volume and 
muting, pause recording and switch solo on and off in the corresponding Cubase LE tracks.

Operating the fader section

1 Assign the desired Cubase LE 
tracks (channels) to the fader 
section.

About banks

After setting up control surface operation, the 
main parameters of Cubase LE can be operated 
using the R16’s fader and status keys.

A group of tracks operated by the faders and 
status keys is called a "bank," and one bank 
includes 8 tracks. 

For example, if fader 1 is assigned to Cubase LE 
track 1, tracks 1-8 can be operated as shown in 
the following diagram.

As the diagram shows, pressing the [9~16tr 
(Bank>)] key once switches the allocations as 
shown below.

Control 1 2 3 4 5 6 7 8

Track Tr.9 Tr.10 Tr.11 Tr.12 Tr.13 Tr.14 Tr.15 Tr.16

 [1-8Tr] Key (< BANK) 
   Tracks (channels) assigned to the fader section 

are moved backward by eight tracks.

 [9~16Tr] Key (BANK >) 
   Tracks (channels) assigned to the fader section 

are moved forward by eight tracks.

2 Use the faders to control the 
volumes of the corresponding 
tracks.

The faders control the volumes of their 
respective tracks. Change the master 
volume by moving the [Master] Fader.

Control 1 2 3 4 5 6 7 8

Track Tr.1 Tr.2 Tr.3 Tr.4 Tr.5 Tr.6 Tr.7 Tr.8
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3 Press the MASTER track status key 
to cycle through  the functions of 
the individual track status keys.

By pressing a track status key, you can 
toggle solo, mute and record enable on 
and off for the corresponding track.

R16 level meters 
(audio interface use)

Each leve l meter other 
than the MASTER displays 
the s igna l immediate ly 
before sending it to the 
computer.

The master ing leve l 
meter displays the re-
turning signal from the 
computer.

Checking DAW recording levels
By setting “REC SIGNAL” to “WET” (signal with 
effect) or “DRY” (no effect), you can send signals 
to the computer with or without being processed 
by the R16’s insert effects. 
The recording levels of the sent signals are 
displayed on the level meters. The signals shown 
on the mastering level meter and each level meter 
are different. 

Please adjust the 
l e ve l  m e te r  s o 
that i t does not 
light the red clip 
indicator.

Red light
(clipping)

Each press of the 
MASTER track key 
changes the function in 

mute>rec>solo order.

Sample Rate=48.0kHz
s:Solo
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Setting up function keys
The five keys above the transport keys can be used as function keys (F1~F5) and assigned 
as you desire.

Function key setup method

1 Open the Device Setup Dialog 
Box in Cubase LE.

2 Commands can be assigned in the three 
columns displayed on the right side of the 
window.

Select Mackie Control 

3 From the (Button) column 
choose the function key [F1~F5] 
to be assigned a Cubase LE 
function.

5

7 Press the “Apply” button.

Choose the type of Cubase LE 
function from the Category pop-
up menu.

6 Click on the “Command” column 
and select the desired specific 
Cubase LE function from the 
pop-up menu.
(The contents of this pop-up menu will 
be different depending on the category 
chosen.)

4 Click on the “Category” column 
for that key.

  HINT
The display of MENU etc. may be different 
depending on the version of Cubase LE.
Please refer to your Cubase LE manual.
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Control surface functions quick reference guide

Control Explanation

Fader section

Status Key Toggles mute, record enable or solo on the track on/off.

[MASTER] Status Key Switches the function of the status keys

Fader Controls the volume of the corresponding track

[MASTER] Fader Controls the master volume

Transport section

[Curser] Keys        Performs the same functions as the arrow keys on the computer

Dial Moves the cursor position

[REW] Key Rewind

[FF] Key Fast forward

[STOP] Key Stop

[PLAY] Key Play

[REC] Key Record

[AUTO PUNCH I/O] Key Depends on the [F1] key setting

[A-B REPEAT] Key Depends on the [F2] key setting

MARKER [|<<] Key Depends on the [F3] key setting

MARKER [>>|] Key Depends on the [F4] key setting

[MARK] Key Depends on the [F5] key setting

Control section    
[1-8Tr] Key Moves one bank backward

[9-16Tr] Key Moves one bank forward
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The mixer in audio interface mode
In audio interface mode you can make a mix for monitoring using the R16’s internal mixer. In 
addition, you can adjust the balance of the internal mixer and the sound from the computer.

  NOTE
The R16 REVERB SEND, PAN, VOLUME and 
STEREO LINK settings are all saved when you 
terminate audio interface mode and can be used 
again the next time by choosing [CONTINUE] when 
you relaunch audio interface mode.

You can be adjust the REVERB SEND, PAN, 
VOLUME and STEREO LINK settings as in 
recorder mode.
Operation is the same as in recorder mode.
(Reference: OPERATION MANUAL P.37)

The PAN/EQ Menu

Input1
VOLUME=0

VOLUME

You can set the volume levels for INPUT 1~8 between 
0~127 (increments of 1). 100 is the default.

This is the first menu item displayed when you push the 
[PAN/EQ] key in audio interface mode. 

Input1
REVERB SEND=0

SEND REVERB

You can change the reverb send levels for INPUT 1~8 
from 0~100 (increments of 1) with 0 as the default (same 
as in recorder mode).

Reverb only affects the monitored signal.

Input1
   |-----+---|-|

PAN (BALANCE)

You can change the pan for INPUT 1~8 between 
L100~R100 (increments of 2) with C (center) as the 
default (same as in recorder mode). 

Input1
STEREO LINK On

Link even and odd numbered INPUTS to handle them 
as a stereo pair.

On/Off with “Off’ as the default.
By setting up a stereo link, REVERB SEND, PAN and 
VOLUME track parameters can be applied to even and 
odd inputs simultaneously. The odd numbered fader 
will be active (same as in recorder mode).
(Reference : OPERATION MANUAL P.20  )

Volume, reverb send and pan

[BALANCE]

In audio interface mode the balance of the 
signals monitored from the inputs and the signals 
returning from the computer can be adjusted 
with the [BALANCE] knob.

Left

Only the signals 
from INPUT 1~8

Right

Only the DAW 
stereo signal

STEREO LINK
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Tuner
The R16’s tuner can be used in the same way as in recorder mode. For further details 
please consult the OPERATION MANUAL.

1 Press [TOOL].

Select >TUNER2
TOOL
>TUNER

Change 
menu

Push [Enter].

CHROMATIC TUNER
TOOL>TUNER>CHROMATIC

4 CHROMATIC      440Hz

Select the base pitch 
and tune the instrument.

CHROMATIC      440Hz
>>A

Displays the note closest to the input 
signal.

Displays whether the pitch is higher or 
lower than the displayed note.

Change the base pitch

3 Select tuner type.

Change 
tuner type

Change 
tuner type

GUITAR         440Hz
<E>          String6

            Chord / Note

Tuner Type

CHROMATIC      440Hz

Base Pitch

  NOTE
Tuner settings are saved when you terminate audio 
interface mode and can be used again the next 
time by choosing [CONTINUE] when you relaunch 
audio interface mode.

  HINT
 · The default base pitch is 440 Hz.
 · Tuners other than the chromatic tuner can be used.
   (Reference : OPERATION MANUAL P.31 )
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Effects in audio interface mode
The R16’s insert and send return effects can both be used when the sampling wavelength is  
set to 44.1 kHz. Basic operation is the same but there are a few differences in the menus.

  NOTE
 · Effects can only be used when the sampling rate 

is 44.1 kHz.  At all other times it is turned OFF.
 · Insert and send return effect settings are saved 

when you terminate audio interface mode and 
can be used again the next time by choosing 
[CONTINUE] when you relaunch audio interface 
mode.

Insert effect Send return effect (reverb)

As in recorder mode, select the insert location 
and the insert effect algorithm, as well as the 
effect patches to be applied to the recording 
signal.  

Insert effect menu

No.00:Standard
>INPUT SOURCE

Select the insert location

You can set it for any INPUT from 1~8.

(Reference : OPERATION MANUAL P.49)

No.00:Standard
>REC SIGNAL

Apply the effect only to monitoring

If you set “REC SIGNAL” to “Dry,” the effect will only be 
applied to the monitoring signal and will not affect signals 
recorded in DAW software. 

(Reference : OPERATION MANUAL P.55)

When in audio interface mode reverb can only 
be used for monitoring. As in recorder mode, 
you can use the [SEND RETURN EFFECT] menu 
to change the patch and the [PAN/EQ] menu to 
set the send level that adjusts the depth of the 
reverb signal.

Send return effect menu

SEND REVERB
No.00:TightHal

REVERB SEND

By altering the send level of the REVERB you can adjust 
the depth of the added signal.

In audio interface mode the [SEND RETURN 
EFFECT] key opens the “SEND REVERB” menu, 
which is different from the recorder mode.
(Reference: Printed Manual P.35~45)
(Reference: Audio Interface Manual P.25)
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Working with patches
After you have made many edits, you might want to restore pre-edited settings by initializing the 
patch. This will return it to its factory preset condition.

  HINT
Even if you have not imported patches the initial 
settings of patches that were used in the recorder 
mode can be used.

1 Pressor
Turn EFFECT On if Off

press [ENTER].
If “EFFECT Off” is displayed,

Patch initialization (factory reset)
EFFECT> select patch> PATCH INITIAL

Change 
menu

3 Press [  ].

No.00:Standard    
>EDIT

CLEAN          <IN1>
No.00:Standard	

2 Select algorithm/patch.

Change 
menu

PATCH
Initial?

5 Confirm.

Press [ENTER].

Select >PATCH INITIAL.4

Press [ENTER].

No.00:Standard    
>PATCH INITIAL

No.00:REVERB    
>PATCH INITIAL

Change 
menuSend return effect (only reverb) example

Insert effect example

Select an insert effect or send return 
effect patch

Press either INSERT EFFECT or SEND RETURN 
EFFECT and select a patch from an algorithm.
(Reference: OPERATION MANUAL P.48)

Patch editing and renaming (EDIT)
By adjusting the effect module parameters you can set 
it to create the desired result. You can also change the 
name.
(Reference: OPERATION MANUAL P.53)

Importing patches (IMPORT)
All algorithms (as well as reverb patches) from the 
effects of the project selected on the R16 can be 
imported and saved as a single patch.
(Reference: OPERATION MANUAL P.54)
*In the audio interface mode, one complete set of effect 
data is saved for the mode. There are no project based 
settings.

Saving patches (SAVE)
Adjusted patches can be saved.
(Reference: OPERATION MANUAL P. 53)

Initializing patches (INITIAL)
Restores patches to their original factory settings (only 
available in audio interface mode).

Patch operation menus

Patch operations
For both insert and send return effects 
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Cubase LE　Startup Guide

New audio track

Record buttonStop button Play button

a

b

c

d

e

f

g

h

i

Install Cubase LE referring to the bundled 
'Download access code sheet'.

Download the latest driver from ZOOM website
(www.zoom.co.jp) and install it. 

Connect the ZOOM unit to the computer.
Please refer to Operation Manual how to connect.

Startup Cubase LE, select "Device Setup..." from the "Devices" menu, and click "VST audio 
system" in the Devices Column.
Select the downloaded driver or the devices including the ZOOM model names here.
e.g. H Series Multi Track is shown as following.

Select "VST Connections" from "Devices" menu and set the input and output device 
ports to the downloaded driver or the devices including the ZOOM model names.
For multi-track supported models, click "Add Bus" and add the input bus.
e.g. H Series Multi Track is shown as following.

Select "New Project" from the "File" menu.

"Project Assistant" window opens in order to select a project template. Click "More", 
select "Empty", and then click the "Create" button to display the project window. 

Select "Add Track">"Audio" from "Project" menu and add new audio track.

Click "Record" button on the Transport panel and start recording.

Recording starts. Click "Stop" button to stop recording.

Click "Play" button to check the recording.

Download access code sheet

This is all for the basic setting.
For more information, please refer to the Documentation from "Help" in Cubase LE  or  
visit Steinberg website （www.steinberg.net/en/home）.

The Menu items are subject to change. Please refer to the Cubase LE Operation Manual in such cases.

©2014 ZOOM CORPORATION  Z2I-2186-02




